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Introductions
Dr. Steffi LaZerte

Background in Biology (Animal Behaviour)
Working with R since 2007

Professional R programmer/consultant
since 2017

rOpenSci Community Assistant
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https://ropensci.org/

Introductions

Dr. Alex Koiter (Today’s Teaching Assistant)

Physical Geographer
Working with R since 2010

Associate Professor in Geography and Environment,
Brandon University

Developer of R package mbquartR

mbquartR
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https://docs.ropensci.org/mbquartR/

What about you?

e Name
e Background (Role, Area of study, etc.)
e Familiarity with R or Programming

e Creatures (furry, feathery, scaley, humanoid, green or otherwise)?

>
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About this Workshop

Format

e | will provide you tools and workflow to get started with R
o We’ll have hands-on activities, lectures, and demonstrations
e Video on or off, however works best for you!

Questions

e Ask questions by un-muting, or ask in the chat
= Workshop-related questions we’ll address together

= Specific, system-related problems, Alex will help you in the “Troubleshooting Room”

Getting help

e Share your screen
e Share your code - https://codeshare.io/5zY31W
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https://codeshare.io/5zY31W

About this Workshop

R is hard: But have no fear!

e Don’t expect to remember everything!

e Copy/Paste is your friend (never apologize for using it!)
e Consider this workshop a resource to return to
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What is R?
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RStudio vs. R

RStudio R

e RStudioisnotR

e RStudio is a User Interface or IDE (integrated development environment)
= (i.e., Makes coding simpler)

10 / 54



Open RStudio
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Ris a Programming language

e You need to know the language (i.e., the code)

e Computers don’t know what you mean, only what you type (unfortunately)
e Spelling, punctuation, and capitalization all matter!

For example
R, what is 56 times 5.8?

56 * 5.8

[1] 324.8
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Use code to tell R what to do
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Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?

mean(c (1, 2, 3, 4))

[1] 2.5
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Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?

mean(c (1, 2, 3, 4))

[1] 2.5

R, save this value for later

steffis _mean <- mean(c (1, 2, 3, 4))
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Use code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?

mean(c (1, 2, 3, 4))

[1] 2.5

R, save this value for later

steffis _mean <- mean(c (1, 2, 3, 4))

R, multiply this value by 6

steffis mean * 6

[1] 15
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Why R?
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R is hard

# Get in circle around city
circle =- data.frame()
cutoff <- 10
for(i in unique(gpsSregion)) {
n <- nrow(gps[gpsSregion == 1i,]) ##number of IDs

if(i == "wil") tmp <- geocode("Williams Lake, Canada")
if(i == "kam") tmp <- geocode("Kamloops, Canada")
if(i == "kel") tmp <- geocode("Kelowna, Canada")

temp <- data.frame()
for{a in 1:n){
if(a == cuteff) temp <- rbind({temp, gcDestination(lon tmpSlon,
lat = tmpSlat,
bearing = (a*(368/{cutoff))-360/(cutoff)),
dist = 20,
dist.units = "km",
model = "WGS84"))
if(a > cutoff) temp <- rbind(temp, gcDestination(lon = tmpSlon,
lat = tmpSlat,
bearing = ((a-cutoff)*(360/(max{table(gpsSregion

))-10))-360/(max(table(gpsSregion) ) -cutoff)),
dist = 35,
dist.units = "km",
model = "WCS84")})
}

circle <- rbind{circle, cbind(temp,
region = 1,
hab = gpsShab[gpsSregion == 1],
spl = gpsSspl.orig[gpsSregion == i],
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But R is powerful (and reproducible)!

%) Global Environment Q
Data
O fish 172 obs_.o hle i
O telem_total 0
Values

tz "Etc/GMT+8"
Functions

load_data function (x)
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But R is powerful (and reproducible)!

%) Global Environment « Q
Data
O fish 172 obs_.o hle =
O telem_total )
Values

tz "Etc/GMT+8"
Functions

load_data function (x)

(I made these slides with a mix of R and Quarto)
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R is also beautiful

60:N =
58<N -
ZONE_NAME
562N -
. Boreal Plain
. Boreal Shield
. Hudson Plain
i . Prairie
| |
| | Southern Arctic
Taiga Shield
52:N =
50-N =

102:W 100:W  98W  96:W  94W  92:W
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R is affordable (i.e., free!)

R is available as Free Software under the terms of the Free
Software Foundation’s GNU General Public License in source
code form. It compiles and runs on a wide variety of UNIX
platforms and similar systems (including FreeBSD and Linux),

Windows and MacOS.
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S yn drome



Imposter Syndrome Reality

Impost:

Sy n d ro m e What | think others knaw What | know
ﬁ What others know

David Whittaker
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Syndrome == ®

| What others know
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The Goal

ak -FirS{' | wag Ii.l(.e...

Artwork by @allison_horst
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https://github.com/allisonhorst/stats-illustrations

The Goal

Ak first | was [ike..

bi AR et Neamdte  \ 1 — 'ﬁ
Haovst 18

Artwork by @allison_horst
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https://github.com/allisonhorst/stats-illustrations

About R
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Code, Output, Scripts

Code

e The actual commands

Output

e The result of running code or a script

Script
o Atextfile full of code that you want to run
e You should always keep your code in a script

23 /54



Code, Output, Scripts

Code

e The actual commands

Output

e The result of running code or a script

Script
o Atextfile full of code that you want to run
e You should always keep your code in a script

For example:

mean(c (1, 2, 3, 4))

[1]

2.5

@ | 4_analysis.R

15
16
17
18
19
20
21
22
23
24
25
26
27
28
25
30
31
32
33
34
35
36
37
a8
35
46
41
42
43
44
45
46
1:1

] Source on Save | O - 0
#' # Setup
## @knitr setup
library(tidyverse)
library(stringr)
library(gridExtra)
libraryigrid)
library(boot)

theme_cust <- theme_bw() +
theme(panel.grid = element_blank())

#' Load data
d <- read_csv("../Data/Datasets/pca.csv") %=4%
mutate(hab_c = ifelse(hab = @, "Urban", "Rural"))

summary(dshab)

#' # Plotting
d_sum <- d %=%
group_by(hab_c) ¥=%
summarize(prop = sum(atypical_c) / length(atypical_c))

d_n <- count(d, atypical_c, hab_c)

#' # Sample sizes

## @knitr sample_size

count(d, hab_c)

count(d, atypical_c)

count(d, lowhigh, moncotone, freq_sweep)

count(d, region)

count{d, project = ifelse(str_detect(id, "MC[BC]{1}[@-2]{2}"), "Steffi",

(Top Lewvel) =

Code
Output
Script

#Run e {* Source -

R Scripe =
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RStudio Features

Projects

e Handles working directories
e Organizes your work
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RStudio Features

Projects

e Handles working directories
e Organizes your work
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RStudio Features

Projects

e Handles working directories
e Organizes your work

Changing Options: Tools > Global Options

e General > Restore RData into workspace at startup (NO!) Let’s setup a projectin
RStudio!

e General > Save workspace to on exit (NEVER!)

e Code > Insert matching parens/quotes (Personal preference)
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RStudio Features

Projects

e Handles working directories
e Organizes your work

Changing Options: Tools > Global Options

e General > Restore RData into workspace at startup (NO!) Let’s change some
options in RStudio!

e General > Save workspace to on exit (NEVER!)

e Code > Insert matching parens/quotes (Personal preference)
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RStudio Features

Projects

e Handles working directories
e Organizes your work

Changing Options: Tools > Global Options

e General > Restore RData into workspace at startup (NO!) Let’s change some
options in RStudio!

e General > Save workspace to on exit (NEVER!)

e Code > Insert matching parens/quotes (Personal preference)

Packages

e Can use the package manager to install packages
e Can use the manager to load them as well, but not recommended
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Getting Ready

& Open New File

(make sure you’re in the RStudio Project)
# Write Library (tidyverse) atthetop

B Save this new script

(consider names like intro.ROr1_getting started.R)
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Your first real code!
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot?2)

# Now create the figure

ggplot (data = penguins, aes(x = body mass_g, y = bill_length_mm, colour = species)) +
geom_point ()

1. Copy/paste or type this into the script window in RStudio
e You may have to go to File > New File > R Script

2. Click on the first line of code

3. Run the code
e Click ‘Run’ button (upper right) or
e Usetheshort-cutctri-Enter

4. Repeat until all the code has run
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot2)

# Now create the figure

ggplot (data = penguins, aes(x = body_mass_g, y = bill length_mm,

colour

1
2
3
4
5
6
7

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

(*geom_point () ) .
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First Code

# First load the packag
library (palmerpenguins)
library (ggplot2)

# Now create the figure

y

= bill_ length_mm,

ggplot (data = penguins, aes(x = body_mass_g,

1
2
3
4
5
6
7

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

(*geom_point () ) .
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First Code

# First load the packages
library (palmerpenguins)

1
2
3 library (ggplot2)
4
5
6
7

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

(*geom_point () ) .

# Now create the figure
ggplot (data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour =
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot2)

# Now create the figure

ggplot (data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +

1
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7

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot2)

# Now create the figure

y

= bill_length_mm,

ggplot (data = penguins, aes(x = body_mass_g,
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geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

(*geom_point () ) .
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot2)

# Now create the figure

ggplot (data = penguins, aes(x = body_mass_g, y = bill length_mm,

colour

1
2
3
4
5
6
7

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

(*geom_point () ) .
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First Code

# First load the packages
library (palmerpenguins)
library (ggplot2)

# Now create the figure

1
2
3
4
5
6 ggplot (data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
.

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the s
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First Code

1
2
3 library (ggplot2)
4
5
6
y

geom_point ()

Warning: Removed 2 rows containing missing values or values outside the scale range

("geom_point () ) .

# First load the packages
library (palmerpenguins)

# Now create the figure
ggplot (data = penguins, aes(x = body_mass_g, y = bill_ length_mm, colour =

BD"' @
®
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R Basics: Objects

Objects are things in the environment

(Check out the Environment pane in RStudio)
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functions()
Do things, Return things

Does something but returns nothing
e.g., library () - Loads an R package so we can use it’s functions and other objects it supplies

library (palmerpenguins)

60 -

Does something and returns something

e.g.,ggplot () - Creates and returns a basic plot

ggplot (data = penguins, aes(x = body_mass_g, y = bill_length_mm))

gth_mm

bill_len

40-

3000 4000 5000
body_mass_g

6000
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functions()

e Functions can take arguments (think ‘options’)

® data, x,y,colour

ggplot (data = penguins, aes(x = body_mass_g, y = bill length_mm, colour = species)) +
geom_point ()
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functions()

e Functions can take arguments (think ‘options’)

® data, x,y,colour

ggplot (data = penguins, aes(x = body mass_g, y = bill_ length_mm, colour = species)) +
geom_point ()

e Arguments defined by name or by position

With correct position, do not need to specify by name

By name: By order:
mean(x = c(1, 5, 10)) mean (c (1, 5, 10))
[1] 5.333333 [1] 5.333333

38 /54


file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html

functions()
Watch out for ‘hidden’ arguments
By name:

mean(x = c(1, 5, 10, Na),
na.rm = TRUE)

[1] 5.333333
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functions()

Watch out for ‘hidden’ arguments

By name: By order:
mean(x = c(1, 5, 10, Na), mean (c (1, 5, 10, NA),
na.rm = TRUE) TRUE)
[1] 5.333333 Error in “mean.default () :

!' "trim' must be numeric of length one
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functions()

Watch out for ‘hidden’ arguments

By name: By order:
mean(x = c(1, 5, 10, Na), mean (c (1, 5, 10, NA),
na.rm = TRUE) TRUE)
[1] 5.333333 Error in “mean.default () :

!' "trim' must be numeric of length one

This error states that we’ve assigned the argument t rim to a non-valid argument

Where did trim come from?
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R documentation

?????
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R documentation

“mean

mean {base} R Documentation

Arithmetic Mean

Description

Generic function for the (trimmed) arithmetic mean.
Usage

mean(x, ...)

## Default S3 method:

mean(x, trim = ©, na.rm = FALSE, ...)
Arguments
X An R object. Currently there are methods for numeric/logical vectors and date, date-

time and time interval objects. Complex vectors are allowed for trim = 0, only.

trim  the fraction (0 to 0.5) of observations to be trimmed from each end of x before the
mean is computed. Values of trim outside that range are taken as the nearest
endpoint.

na.rm a logical value indicating whether NA values should be stripped before the
computation proceeds.

further arguments passed to or from other methods.
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Data

g Generally kept invectors Ordata.frames (also tibbles)

e These are objects with names (like functions)

e Here are two built-in examples (part of R)

Vector (1 dimension)

month.name

[1] "January" "February" "March"
[4] "April" "May" "June"
[7] "July" "August" "September"
[10] "October" "November" "December"

Data frame (2 dimensions)

mtcars

Mazda RX4

Mazda RX4 Wag
Datsun 710

Hornet 4 Drive
Hornet Sportabout
Valiant

Duster 360

Merc 240D

Merc 230

Merc 280

Merc 280C

Merc 450SE

Merc 450SL

Merc 450SLC
Cadillac Fleetwood
Lincoln Continental

mpg cyl

21.
21.
22.
21.
18.
18 .
14.
24.
22.
19.
17.
16.
17.
15.
10.
10.

(@)

DN W 0N 0 W d B 0O

00 O OO GO 0O Oy O » I O O O O B OO O

disp

160.
160.
108.
258.
360.
225
360.
146.
140.
167.
167.
275.
275.
275.
472.
460.

o

O O 0O O 0O Oy O W ~J O O O O O O

hp
110
110

93
110
175
105
245

62

95
123
123
180
180
180
205
215

rows x columns

drat
.90
.90
.85
.08
.15
.76
.21
.69
.92
.92
.92
.07
.07
.07
.93
.00

WD W W WwWWw W W wWwwhDwwww w

OO W W W W WwWwWw W W W NN DN

wt

.620
.875
.320
.215
.440
.460
.570
.190
.150
.440
.440
.070
.730
.780
.250
.424

gsec vs

16.
.02
18.
19,
17.

17

20

17

46

61
44
02

o B2
15.
20.
22.
18.
18.
17.
.60
18.
17 .
17.

84
00
90
30
90
40

00
98
82

O O o o ok bk POk Ok PO O
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Your Turn: Vectors and Data frames

Try out the following code...

e Here we will make a vector and a data frame
e Whatis the outputin your console?

e How does your environment change (upper right panel)?

Vectors

fruit <- c("apples", "bananas", "pears", "oranges", "melons")
fruit

Data frames

production <- data.frame (

site = c("east", "east", "west", "west"),
fruit = c("apples", "bananas", "apples", "bananas"),
count = c (20, 60, 30, 50))

production
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Your Turn: Vectors and Data frames

Try out the following code...

e What does : do?
e Whatdoes c () do?
e Why use a comma with data frames?

Vectors Data frames
e Use [index] to access part of a vector e xS$colname to pull columns out as vector
e Can access multiple parts at once e x[row, col] toaccessrows/columns
fruit productionSfruit
fruit[2] production[3]
fruit[2:5] # What does : do? production([3, ] # Why the comma?
fruit[c(l, 3)] # What does c() do? production[3, 1]
[

production[, 1:2]
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Your Turn: Vectors and Data frames

Try out the following code...

Vectors
fruit

[1] "apples" "bananas" "pears" "oranges" "melons"
fruit([2]

[1] "bananas"
fruit[2:5] # What does : do?

[1] "bananas" "pears" "oranges" "melons"

fruit[c(l, 3)] # What does c () do?

"apples" "pears"

Data frames

production$fruit

[1] "apples" "bananas" "apples" "bananas"

production[3]

count
20
60
30
50

DSw N e

production[3, ]

site fruit count
3 west apples 30

production[3, 1]

[1] "west"

production[, 1:2]

site fruit
1 east apples
2 east bananas

# Why the comma?

44 / 54


file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html

Miscellaneous
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R has spelling and punctuation

e R cares about spelling
e Risalso case sensitive! (apple is notthe same as apple)

YError: YError:
»Ervor: YErvor: ®
Error: (EAAA

-CLIck
CLICKETY-

YError:
YError:
YError:
YError:

@allison_bhorst
Artwork by @allison_horst
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https://github.com/allisonhorst/stats-illustrations

R has spelling and punctuation

e Commas are used to separate arguments in functions

This is correct:

mean (c (5, 7, 10)) # [1] 7.333333

This is not correct:

mean (c(5 7 10))
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R has spelling and punctuation

e Commas are used to separate arguments in functions

This is correct:

mean (c (5, 7, 10)) # [1] 7.333333

This is not correct:

mean (c(5 7 10))

>80% of learning R is learning to troubleshoot!

47 / 54


file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html
file:///home/user/1_intro_to_R_answers.html

R has spelling and punctuation

Spaces usually don’t matter unless they change meanings

> ] FALSE
] FALSE
] FALSE
rror: unexpected '=' in "5 > ="

Vol

6
6
= 6

6 1
- 1
= 1

\Y%

# [
# [
# 1
# E

o o1 U1 O

\Y

Periods don’t matter either, but can be used in the same way as letters

(But don’t)

apple.oranges <-— "fruit"
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Assignments and Equal signs

Use <- to assign values to objects

a <— "hello"

Use = to set function arguments

mean(x = c(4, 9, 10))

Use == to determine equivalence (logical)

10 == 10 # [1] TRUE
10 == 9 # [1] FALSE
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Braces/Brackets
Round brackets: ()

e |dentify functions (even if there are no arguments)

Sys.Date () # Get the Current Date

[1] "2026-02-19"
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Braces/Brackets

Round brackets: ()
e |dentify functions (even if there are no arguments)

Sys.Date () # Get the Current Date

[1] "2026-02-19"
e Without the (), R spits out information on the function:

Sys.Date

function ()

as.Date (as.POSIX1t (Sys.time()))
<bytecode: 0x593dl4eaecdel>
<environment: namespace:base>
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Braces/Brackets

Round brackets: ()
e |dentify functions (even if there are no arguments)

Sys.Date () # Get the Current Date

[1] "2026-02-19"
e Without the (), R spits out information on the function:

Sys.Date

function ()

as.Date (as.POSIX1t (Sys.time()))
<bytecode: 0x593dl4eaecdel>
<environment: namespace:base>

() must be associated with a function (well, almost always)
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Square brackets: []

e Extract parts of objects

LETTERS

[1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"
[20] "'1"" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]

[1] "A"

LETTERS [26]

[l] "Z"
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Square brackets: []

e Extract parts of objects

1 LETTERS

[1] "A" "B" "c" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"
[20] "'I‘" "U" "V" "W" "X" "Y" "Z"

1 LETTERS[1]

[1] "A"

1 LETTERS[26]

[1] "Z"
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Improving code readability

Use spaces like you would in sentences:

a <-— mean(c (4, 10, 13))

is easier to read than

a<-mean(c(4,10,13))

(But the same, coding-wise)
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Improving code readability

Don’t be afraid to use line breaks (‘Enters’) to make the code more readable
Hard to read

a <— data.frame(exp —_— C("A", "B", "A", "B", "A", "B") , Sub — C(HA:L", "Al", "AZ"I "AZ", "A3", "A3") , TRy = C(‘

Easier to read

a <_ data.frame (eXp — C(HA", "B", "A", "B"’ "A", "B") ,
SU.b — C("Al ", "Al ", "AZ ", "AZ ", "A3", "A3") ,
res = c¢(10, 12, 45, 12, 12, 13))

(But the same, coding-wise)
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Let’s go!
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